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郑重声明 
 

 

 

 《STC15 单片机实战指南（C 语言版）》 一书以一坚科技研发的飛天三號（FSST15-V1.0）

实验板为硬件平台，以《深入浅出玩转 STC15 单片机》为配套视频，由清华大学出版社权

威出版，并且分别是 STC 官方大学计划和高校高性能联合实验室推荐教程和视频，版权归

作者和清华大学出版社所有。 

本资料以个人学习、工作经验以及宏晶科技单片机技术为素材，以单片机初学者、单

片机项目开发者为对象，教大家如何走进单片机，继而达到开发工程项目为目的。限于时

间和水平关系，资料中难免有过失之处，望各位高手批评指教，多多拍砖，拍累了，你们

休息，我继续上路。 

现已连载的方式免费共享于各大电子网站，供单片机新手们参考学习，可以自由下载

传阅，但未经作者许可，不得用于任何商业目的，转载请注明出处：残弈悟恩

（www.ieeBase.net）。最终完整版以出版社所出书籍为准。 
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飛天三號（FSST15-V1.0）实验板 
 

 

STC 高性能联合实验室专用试验箱学生实验补充开发板 

STC 官方推荐书籍《STC15 单片机实战指南》配套开发板 

STC 大学计划推荐视频《深入浅出玩转 STC15 单片机》配套开发板 

 

 

 

让爱充满大地——花 1秒时间，拯救 1个人，传递 1份爱 

 

声明：只是残弈悟恩爱心的喷发，我得不到一分钱，各位不要多想，谢谢！ 

你知道吗？在非洲北边的某个地区，每一秒都有许许多多的人正在挨饿，每一天至少有

一位儿童死于营养不足。你的一次点击就能让某位穷人得到 1.1 杯食物。当然你可以不相信

有这样的链接或者是骗点击什么的。事实上，网站确实是帮穷人得 1.1 杯食物的，只要你点

进去点击一下中间的黄色按钮，就会出来一系列介绍各种商品的网页（绝对免费的并且不会

下载任何软件，也不会有电脑病毒），同时也会有人因为您的一次点击而得到 1.1 杯食物，

食物是由商家提拱的，但爱心却是您献出的。如果你觉得残弈悟恩在忽悠大家，你不妨可以

在网上查一下是真与假。 

看到这本资料的朋友多数都是电子爱好者、单片机初学者，或者干电子这一行的，管你

是穷学生还是穷工人，只要能上网，只要愿花一秒种就可以了。人生在世，有两件事不能等：

一、孝顺；二、行善。无论你是 LED 小灯、普通灯泡也好，还是荧光灯也罢，最重要就是

要懂得用自身的光去照耀别人，光的强度并不重要。 

点击链接： 

http://www.thehungersite.com/clickToGive/home.faces?siteId=1&link=ctg_ths_home_from_ths_thankyou_sitenav 

 

http://www.thehungersite.com/clickToGive/home.faces?siteId=1&link=ctg_ths_home_from_ths_thankyou_sitenav
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第 2章 欲善其事 必利其器：软硬件平台的搭建和使用简述 

一个人，两脚使劲踩 1 小时的自行车，只能跑 10 公里；开着宝马，一脚轻踩油门 1 小

时就能跑 100 公里；乘飞机，吃着美味、睡着大觉，也能跑 1000 公里。同样的努力，不一

样的平台和载体，结果就是不一样。可问题是如何找到一个好的平台，适合自己的才是最好

的。从无到有，或者到合适，都需要一个由量变到质变的过程。通过这章的学习，力争读者

掌握单片机开发的基本的软件调试环境和硬件开发平台。 

2.1 硬件平台—FSST15 开发板 

工欲善其事必先利其器。单片机的学习书本的理论知识，更需要实际操作的硬件平台，

否则一切是都是空中楼阁。除了硬件平台，还需软件开发工具，用于软件开发的有 Keil、

IAR、ST VisualDevelop 等，用于下载的有 STC-ISP、ST VisualProgrammer 等，但有些开

发软件自带了下载功能。由于此书以 STC 的 IAP15W4K58S4 为核心处理器，所以这里主要介

绍用于 STC 单片机开发的 Keil μVision5 和下载用的 STC-ISP。关于 PCB 的绘制软件，笔者

特意写了一章，等到后面再详细讲解，还有读者最能学习一下上位机编程软件（详见《深入

浅出玩转 51 单片机》一书），这样单片机基本的开发工具就基本满足了。 

 本书所有实例是基于 FSST15（飛天三號）开发板的，该开发板由残弈悟恩历时半年亲

自研发，无论是从原理图的设计、元件的选型、模块的配置、PCB 的绘制都是精心筛选、策

划的，让每个读者“玩”起来感觉舒心、快捷、方便、全面。配套的资料齐全、代码编程风

格规范，实例生动、可移植性高，最震撼的是残弈悟恩贴身回答读者学习过程中遇到的所有

问题。 

2.1.1 FSST15 开发板功能框图 

 开发板功能框图如图 2-1 所示，开发板以 IAP15W4K58S4 为核心芯片，周围配备丰富的

外围设备，一板在手，学习无忧。 

 

图 2-1 FSST15 开发板资源分布图  

2.1.2 FSST15 开发板基本配置 

（1）主芯片是 STC 公司的 IAP15W4K58S4，芯片特性见本书第 1章。 
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（2）特殊端口和 2组 I/O 口全部用优质的排针引出，方便扩展。 

（3）集成了 STC 官方推荐的 USB 转串口 IC（CH340T），实现一线下载、调试、供电，

还可与上位机通信。 

（4）集成有 STC 的另外一颗单片机——STC15W104，配合外围器件，便可实现一键自动

（不需要冷启动）下载程序。 

（5）一个电源开关、电源指示灯，电源也用排针引出，方便扩展。 

（6）具有一键开关键、模式设置等功能。 

（7）搭载一颗 5V转 3.3V 芯片，便可为板子提供稳定的电源。 

（8）12 个 LED，三种颜色，并且排布为交通灯形式，不仅可实现流水灯、跑马灯等试

验，还可作交通灯实验。 

（9）8 位共阴极数码，由 STC 官方推荐 74HC595 和三极管（扩流）驱动，便可做静、

动态数码管实验。 

（10）LED 点阵（8×8），可实现图形的基本显示和移动算法。 

（11）一个 1602 液晶，可以做液晶实验； 

（12）电机驱动接口一个，可以做步进电机、直流电机实验； 

（13）附带万能红外接收头，配合遥控器做红外编、解码实验； 

（14）16 个按键组成了矩阵按键，可学习独立按键、矩阵按键的使用； 

（15）4 个独立按键，借助 STC 单片机强大的 A/D 转换功能实现人机操作； 

（16）一个触摸按键，借助 STC 单片机强大的 A/D 和 PWM 功能实现； 

（17）一个电位器，可做 A/D 转换试验； 

（18）双节滤波电路，可用 PWM 功能实现 D/A 实验； 

（19）EEPROM 芯片 AT24C02，学习 I2C 通信试验； 

（20）时钟芯片 PCF8563，可以做时钟试验，该芯片还可以输出可编程的 PWM 波形； 

（21）温度传感器芯片 LM75A，配合数码管做温度采集、显示实验，结合上位机还可做

更多的实验； 

（22）集成一颗 RDA5807M 收音机芯片，可直接将开发板做成收音机； 

（23）集成一颗 SP3485 芯片，可实现 RS485 通信实验； 

（24）搭载一个 WIFI 模块接口，配合 WIFI 模块可以实现物联网控制实验； 

（25）搭载一个 2.4G 无线接口，配合无线模块，可实现无线通信实验； 

（26）结合外围器件做 RTX51 Ting 操作系统试验，为以后学习 μCOS、Linux、winCE

等操作系统奠定基础。 

2.2 开发环境—Keil μVision5 

此书，所有的开发实例全是基于 Keil μVision5 的，因此以 Keil μ Vision5 为例来讲

解。先 COPY 点历史，Keil 公司是一家业界领先的微控制器（MCU）软件开发工具的独立供

应商。Keil 公司由两家私人公司联合运营，分别是德国慕尼黑的 Keil Elektronik GmbH 和

美国德克萨斯的 Keil Software Inc。Keil 公司所制造和销售的开发工具种类比较多，包括

ANSI C 编译器、宏汇编程序、调试器、连接器、库管理器、固件和实时操作系统核心（real-time 

kernel）。有超过 10 万名微控制器开发人员在使用这种得到业界认可的解决方案。其 Keil 

C51 编译器自 1988 年引入市场以来成为市面上的行业标准，并支持超过 500 种 8051 变种。

Keil 公司 2005 年由 ARM 公司收购。其两家公司分别更名为 ARM Germany GmbH 和 ARM Inc。

Keil μ Vision5（以下简称 Keil5）是 2013 年 10 月由 ARM 公司发布的，引入灵活的窗口管

理系统，使开发人员能够使用多台监视器，并提供了视觉上的界面窗口，其位置完全可控。

新的用户界面可以更好地利用屏幕空间和更有效地组织多个窗口，提供一个整洁，高效的环
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境来开发应用程序。新版本支持更多最新的 ARM 芯片，还添加了一些其他新功能。 

要学习单片机，Keil5 必须能熟练操作，说到熟练不是一个选项一个对话框的去查牛津

词典，死背每个选项的意思，没必要，而是在实践开发中用到什么，再去查什么，查的多了、

用的多了，自然就熟悉了。万物之规律----二、八分，什么意思，例如这个社会，20%的人

掌握着 80%的财富。同样，对于 Keil5 软件，只需用 20%的操作就可以实现 80%的功能了。

因此，大家只需按本书操作的实例，一步一步操作一遍，肯定就会掌握。 

2.2.1 Keil μVision5 的安装 

要使用 Keil5，首先得在 PC 机上安装该软件，接下来简述 Keil5 的安装过程和软件的

破解。在此之前笔者建议读者先在某一个盘下新建一个文件，起名为：Keil5（例如：D:Keil5），

这样便于软件的管理和以后系统文件的查找。 

1.安装软件 

打开随书（或开发板）附带的光盘，找到 Keil5 文件夹并打开，接着双击“mdk_513”

应用程序，之后单击“Next”按钮，则会弹出一个“License Agreement”对话框，此时在

“I agree to …”前打勾并单击“Next”按钮，接着是一个让读者选择安装路径的对话框，

单击“Browse”按钮选择刚刚新建的文件夹（D:Keil5）。之后需要读者填写一些个人信息，

这里四个框随便填（例如：ss、bc），再单击“Next”按钮，接着就是一个正在安装的界面

图，稍等片刻，软件就会安装完毕，最后单击“Finish”按钮，这样软件就安装完毕了，之

后就可踏上编程之旅了。 

2.安装软件库 

Keil5 不同于以前的几个版本（Keil4、Keil3、Keil2），安装完软件之后还需要安装库，

这样我们才能够进行后续的操作。读者需要注意的是，由于笔者不仅用 STC 单片机开发工程，

同时还会根据需求，选择一些 ARM 核的处理器来开发项目，因此笔者安装的是 MDK

（Microcontroller Development Kit）版本的软件，至于如何安装 ARM 核处理器的开发环

境，读者可自行查阅资料。当我们安装完软件之后，Keil5 会自动弹出如下的安装包对话框，

如图 2-2 所示。 

 

图 2-2 Pack Installer 安装包对话框 

进行到这步读者可以直接关闭即可，因为这个安装包主要包括一些三星、意法半导体等
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等的高端处理器，而未包含 STC 公司的单片机，那如何安装 STC 公司的单片机，其实很简单，

STC 公司为了解决此问题，他们在自己的 STC-ISP 软件上加入安装库的功能，读者只需进行

简单的操作，就可以添加 STC 单片机到 Keil5 中。 

打开 STC-ISP 软件，选择“Keil 仿真设置”选项卡，如图 2-3 的“1”所示，接着单价

“2”所示的按钮，此时会弹出如图 2-4 所示的 Keil5 安装路径文件夹选择对话框，此时我

们只需定位到安装目录（图中为笔者的安装目录，读者的自行设置）即可。 

 

图 2-3 添加 STC 库到 Keil5 中选择对话框 

 
图 2-4 Keil5 路径选择对话框 
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3.和谐软件 

Keil5 软件网络上流行着破解版，但是出于对知识产权和此软件辛勤劳作人员的尊重和

支持，笔者建议有经济实力的公司和个人最好购买正版软件，购买途径可联系深圳米尔科技

等，但对于穷学生，请大家自行解决，这里不赘。这样，Keil5 犹如世外桃源，只待读者去

欣赏花香鸟语、万物复苏的美景了。 

4.KeilMDK 和 KeilC51 的兼容性设置 

有些读者可能和笔者一样，会面临同时开发 ARM 核和 STC 单片机的双重任务，可开发

ARM 核这样的 Keil5 软件名称为“MDK”，而开发 STC 单片机需要“Keil C51”,因此两者需

要相关的设置，才能将两个软件完美集合，而不是一台 PC 机上安装两个 Keil5 软件，具体

整合的步骤如下。 

(1)安装 KeilC51，并 XX，安装目录 C:\KeilC51\。 

(2)安装 KeilMDK，并 XX，安装目录 C:\KeilMDK\。 

(3)把 C:\KeilC51\ 里面的 C51 文件夹复制到 C:\KeilMDK\ 里。 

(4)把 C:\KeilC51\ 里面的 UV4 文件夹复制到 C:\KeilMDK\ 里，提示有同名文件都不

要覆盖。 

(5) C:\KeilC51\TOOLS.INI 文件里面的内容复制到 C:\KeilMDK\TOOLS.INI 文件后

面，并且把所有的“KeilC51”替换为“KeilMDK”。 

以上，若文件中没有 KeilC51，那么不用管，直接复制粘贴。这样一个 KeilMDK 就可以

兼容 C51 了。最后，关于 “KeilMDK”和“KeilC51”区别,请读者自行查阅了解，这里不赘。 

2.2.2 Keil μVision5 的工程建立过程 

说明一点，讲述 Keil5 的建立过程之前，先在 E盘（路径当然可以随便，根据个人习惯

吧）下新建一个文件夹，以便存放工程，文件命名为：我的第一个工程。特别提醒，这么取

名是便于新手们理解，但笔者强烈建议以后不要用中文来命名，因为一些软件是不支持中文

的，例如开发 FPGA 的 Quartus II 等。所以从开始就应养成良好的习惯，避免以后开发中遇

到这样、那样的问题。对于单片机来说，无论程序的大小，都需要一个完整的工程来支持，

即使点亮一个小小的LED也是需要建立一个完整的工程。接下来讲解Keil5的工程建立过程，

建立过程大致分为下面几个步骤。 

（1）双击桌面 ，打开 Keil5 软件，等 Keil5 软件完全启动后，选择 Project→New 

uVision Project 菜单项，操作界面如图 2-5 所示。 

 

图 2-5 新建工程 

 （2）选择工程的保存路径，笔者就选择 E 盘下的：我的第一个工程文件夹，这样便于
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以后工程的管理，接着在文件名（实质就是工程的名字）处输入文件名：我的第一个工程，

如图 2-6 所示，软件会默认为.uvproj 的扩展名，然后单击“保存”按钮。 

 

图 2-6 保存工程 

 （3）此时弹出如图 2-4 所示的对话框，要求用户选择单片机型号。FSST15 开发板搭载

的是 IAP15W4K58S4，由于前面我们已经添加了 STC MCU 的库，因此这里先如图 2-7 小“1”

选择“STC MCU Database”，之后选择如图 2-7 小“2”所示，选择“STC15W4K32S4”，这

里读者需要注意的， IAP15W4K58S4 隶属于 STC15W4K32S4 系列，因此直接选择

STC15W4K32S4 即可，之后单击“OK”按钮。 
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图 2-7 选择 STC15W4K32S4 

 （4）接着弹出如图 2-8 所示的启动代码选择对话框，这里选择“否”（也可以选择“是”），

所谓启动代码就是处理器最先运行的一段代码，主要任务是初始化处理器模式、设置堆栈、

初始化寄存器等，由于以上的操作均与处理器体系结构和系统配置密切相关，所以一般由汇

编来编写。对于单片机开发来说是否添加都一样，若读者对启动代码感兴趣，自行查阅相关

资料，这里就不做过多说明。 

 

图 2-8 启动代码选择选框 

 此时 Keil5 中只是一个半成品的工程，为何这么说，因为只有虚荣的框架，没有完美的

内涵。接下来开始新建文件，并将文件添加到工程中，为其增砖添瓦吧。 

（5）选择 File→New 菜单项（或者直接 CTRL+N），如图 2-9 所示。 

 

图 2-9 新建文件 

 （6）此时 Keil5 的编辑界面处会有一个“text1”的文本文件，但与刚建立的工程还是

没有一点点关系，接着选择 File→Save 菜单项（或 CTRL+S）保存文件，此时弹出如图 2-10

所示的文件保存对话框，Keil5 已经默认选择了工程所在的文件夹路径，所以只需输入正确

（一定要正确）文件名，文件名字随便，最好是英文的，之后是扩展名“.c”（一定是英文

状态下的.c）。 

注意: 如果是用C语言编写程序，则扩展名必须是.c；汇编编写程序，扩展名必须是.asm；

头文件则为.h。这里文件名可以与工程名相同，也可以不同，然后单击“保存”按钮。 
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图 2-10 文件保存对话框 

 （7）回到编辑界面，单击“Project”窗口处“Target1”前的“+”号，选中“Source Group 

1”并右键单击，弹出如图 2-11 所示下拉菜单，然后选中“Add Files to Group ‘Source Group 

1”菜单项，接着弹出一个对话框，选中上面所保存的文件（也即“我的第一个工程.c”），

如图 2-12 所示，之后单击“Add”按钮添加文件，最后单击“Close”按钮关闭此对话框。 

 

图 2-11 添加现有的文件到“Source Group 1” 
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图 2-12 选择“我的第一个工程.c”文件 

 加入文件之后的工程编辑界面如图 2-13 所示，不知读者注意到了没，这时在“Source 

Group 1”文件夹下多了一个“我的第一个工程.c”的文件（这个就是前面所保存、添加的

c文件），这时源文件与工程就关联起来了，也即工程建立完毕了。 

 

图 2-13 文件加入工程之后的编辑界面 

 （8）编写代码，读者这里只需 CTRL+C、CTRL+V 实例 1 的源代码，暂时不需理会代

码的具体含义，输入代码之后的软件编辑界面如图 2-14 所示。 
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图 2-14 输入程序之后的界面 

 相信通过以上 8 个步骤，读者对 Keil5 的工程建立应该不陌生了吧。接着再介绍几个

Keil5 的常用按钮和一些选项的设置。Keil5 软件的高级应用，请看第四章的模块化编程章

节，哪里有更详细、更全面的应用讲解。 

 可能对于新手们或者英语不好的读者来说，一看到软件有这么多按钮，并且都是英文的，

感觉无从下手。残弈悟恩告诉大家，一定不要怕，这些都是纸老虎。再者，笔者也说过，对

于软件，20%的功能按钮就可以实现 80%的功能操作。接下来介绍几个常用按钮，常用按钮

如图 2-15 所示，其中 9、10、11 并不是按钮，只是便于讲解，才这样图示。 

 

图 2-15“按钮”介绍图 

（1）编译当前操作的文件。 

（2）只编译修改过的文件，并生成用于下载到单片机中的 hex 文件。 

（3）编译工程中所有的文件，并生成用于下载到单片机中的 hex 文件。2、3这两个按
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钮现阶段没什么区别，等到以后编写大型代码时，才能体会到两者的不同。 

（4）用于打开“Target Options”对话框，打开的对话框如图 2-16 所示，并在晶振选

项框中填 11.0592，这里为何选择“11.0592”，具体由我们下载程序时 STC-ISP 软件的设定

决定。接着选择“Output”选项卡，并在“Create HEX File”前复选框中打勾，如图 2-18

所示，别的先统统不予理睬。 

注意：图 2-17 所示的“选择使用内部 IRC 时钟”前的对勾必须勾选，因为 FSST15 开

发板上未搭载外部晶振。 

  
图 2-16 晶振设置对话框 

 

图 2-17 设置 STC-ISP 晶振选择对话框 
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   图 2-18 设置 Options for Targer 对话框 

（5）注释选中行。先选中要注释的代码，之后单击此按钮，就可以加入注释了。 

（6）删除选中行的注释。 

（7）软件进入仿真，具体操作后面章节有详细介绍。 

（8）进入“Configuration”对话框，该对话框主要用来设置字体的大小、颜色，TAB

键的缩进等，具体读者可以自己摸索、研究。 

（9）表示已经生成了可以下载到单片机中运行的 HEX 文件了。 

（10）表示所编写的程序是“0 Error”(真棒，没有错误)。 

（11）编写的代码为“0 Warning”(连警告都没有，你太棒了)，编译程序时，警告是

可以有的，但一定要做到胸有成竹，看该警告是否可以忽略。 

OK，若掌握了这 8 大步骤、11 小步骤，那 Keil5 软件可以说已经被读者所掌握，接下

来就是万事俱备，只欠“编程”了。对于 Keil5 软件，笔者先介绍这么多，到后面学习模块

化编程时，笔者还要详细、深入地讲解踏，那时就可领略 Keil5 的强大了。 

2.3 我的第一个程序——点亮 LED 小灯 

#include "reg52.h" 

sfr   P7   = 0xF8; 

sbit  LED1 = P7^0; 

void main(void) 

{ 

 LED1 = 0; 

 while(1); 

} 
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2.4 辅助开发工具 

2.4.1 CH340 驱动的安装 

 由于好多读者使用的是笔记本电脑，没有串口，所以得用 USB 转串口，在这里先讲述

一下 CH341 的驱动安装，否则是不能给单片机下载程序的。所有用到的软件，读者随时可

以到电子工程师基地的论坛网站（www.ieeBase.net）下载。读者需要注意的是，该驱动分

32 位和 64 位机子，安装时请先查看自己所用电脑的位数，再选择相应的驱动。 

 双击打开 CH341SER 软件，界面如 2-19 所示，直接单击“INSTALL”，这样软件就会自动

安装驱动，过会会弹出一个完成提示对话框，单击“确定”，表示驱动安装完成。 

 
图 2-19 USB 转串口驱动安装界面 

 接着用随开发板附带的 USB 线，连接单片机和电脑，之后右键单击“我的电脑”，选择

“属性”，再单击“设备管理器”，最后单击“端口（COM 和 LPT）”前的“ ”号，此时界

面如图 2-20 所示，表明驱动安装完成，且为读者虚拟了一个 COM 口（COM6），当然可以修

改到别的 COM 口，限于篇幅原因，就不做过多赘述。 

 

图 2-20 驱动安装完成之后的设备管理器界面 

2.4.2 单片机编程软件——STC-ISP 

 STC-ISP 软件，STC 官方更新的比较快，现已经更新到 V6.85H，等读者看到此书的时候，

不知更新到多少版本了，这个读者只能自行体验。为何更新这么快，主要是为了支持后面研
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发的新产品。这里残弈悟恩以 V6.85 为例来讲解，因为笔者一直追求比较赶时髦，例如，

别人用 Keil2 的时候，笔者在用 Keil3，等到别人用 Keil3 的时候，残弈悟恩又开始用 Keil4

了，现在大家都用 Keil4，笔者早已用 Keil5 了。当然不是版本越高，软件就越好，但笔者

总觉得版本越高越智能、越人性化。 

 双击桌面 打开软件，打开的软件如图 2-21 所示。 

 

图 2-21 STC-ISP 软件界面 

 STC-ISP 的操作只需上面 5 步接下来简单介绍一下这 5 个步骤。 

（1）选择所用的单片机型号，FSST15 开发板用的是 IAP15W4K58S4，所以这里选择

IAP15W4K58S4。 

（2）选择 COM 口，其实这里一般不需要选择，软件会自动选择。所要选择的端口号就

是前面安装了 USB 转串口驱动之后虚拟的 COM 口（例如 COM6）。 

（3）选择由 Keil5 生成的 HEX 文件（就是将这个文件下载到单片机中运行的）。 

（4）选择程序运行频率，这里我们选择“11.0592”即可，当然可以选择别的。 

（5）单击“下载/编程”按钮，此时程序就会自动下载到单片机中，在软件的右下方提

示框中会显示一串下载信息，可以不予理会，下载完成后会显示“操作完成！”，表明 HEX

文件已经下载到单片机中了。 

这里需要注意的是，可能开发板的质量、性能不同，有的开发板不支持“115200”这么

高的波特率，这时读者可将软件的最高波特率设置的低一点，例如“9600”，FSST15 开发板

经得起考验，115200 肯定问题；还有，别的开发板不具有自动下载功能（该功能的详细介

绍，后面章节再叙），所以需要用冷启动的方式来为单片机下载程序，具体操作过程读者可

参看《深入浅出玩转 51 单片机》一书。 

OK，STC-ISP 软件先讲述这么多，该软件还带有串口调试助手、波特率计算器、定时器

计算器、软件延时、项目发布等功能，这些就留给读者慢慢研究，这里不赘。 

 单片机的开发中，还可能会用到一些类似于单片机小精灵、数码管取模软件、LCD 取模

软件、LED 点阵取模软件、串口调试助手等小软件，由于篇幅原因，笔者就不一一介绍了，

等到用的时候，再来讲解，或者读者自己摸索一下，工具嘛，其实都不难，凭着感觉就可以

操作了。 
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2.5 课后习题 

（2）掌握 Keil5 的基本用法，能熟练建立工程，并独立能完成单片机的编程流程，继而

生产 HEX 文件。 

（3）能独立将实例 1 编程并生成的 HEX 文件下载到单片机中，并且观察实验现象是否

正确（提示：观察 FSST15 开发板右上角的 D9 LED 小灯发光情况）。 
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